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1 Welcome

The Telescience Resource Kit (TReK) is a suite of software applications and libraries that
can be used to monitor and control assets in space or on the ground. The TReK CFDP
application provides the capability to transfer files using the Consultative Committee for
Space Data Systems (CCSDS) File Delivery Protocol (CFDP).

This tutorial provides step-by-step instructions describing how to perform common
application functions.

This tutorial uses screen dumps taken on a Windows computer. However, the steps are
the same regardless of whether you are running on Windows or Linux.

2 Technical Support

If you are having trouble installing the TReK software or using any of the TReK
software, please contact us for technical assistance:

TReK Help Desk E-Mail, Phone & Fax:

E-Mail: trek.help@nasa.gov
Telephone:  256-544-3521 (8:00 a.m. - 4:00 p.m. Central Time)
Fax: 256-544-9353

If you call the TReK Help Desk and you get a recording please leave a message and
someone will return your call. E-mail is the preferred contact method for help. The e-
mail message is automatically forwarded to the TReK developers and helps cut the
response time. The HOSC Help Desk (256-544-5066) can provide assistance as needed
and is available 24x7.

3 Introduction

The TReK CFDP application provides the capability to transfer files using the
Consultative Committee for Space Data Systems (CCSDS) File Delivery Protocol
(CFDP).

The CCSDS File Delivery Protocol (CFDP) was developed by the Consultative
Committee for Space Data Systems (CCSDS). Official specifications are contained in a
CCSDS document called the CFDP Blue Book (available at www.ccsds.org). The CFDP
protocol provides reliable transfer of files from one computer to another, and has been
designed to work well over space links. It can be used to perform space to ground,
ground to space, space to space, and ground to ground file transfers.



http://www.ccsds.org/
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CFDP requires a sender and a receiver. The sender and receiver must be configured and
running at the same time to perform afile transfer. Each party is referredto as an
“Entity”. The sender is an entity and the receiver is an entity. Each “Entity” must have a
unique Entity ID. For example:

Computer 1 CFDP Computer 2
CFDP Application o CFDP Application
Entity 1D (EID) 1 Entity 1D (EID) 2

M

Figure 1 CFDP Sender and Receiver

To move a file from one computer to another, you will enter one or more CFDP
Commands (primitives) to indicate the action to be taken. The syntax of a primitive is as
follows:

[CFDP Directive] [Transmission] [source-path] [remote-EID] [destination-path]

The TReK CFDP application provides support for CFDP over User Datagram Protocol
(UDP) and CFDP over Bundle Protocol (BP) using the Jet Propulsion Lab (JPL)
Interplanetary Overlay Network (ION) Delay Tolerant Networking software. The CFDP
over UDP configuration option is referred to as Native CFDP. The CFDP over BP
configuration option is referred to as ION CFDP. In the Native CFDP configuration, the
application uses UDP sockets and a Goddard Space Flight Center (GSFC) CFDP library
that performs the CFDP work. Inthe ION CDFP configuration, the TReK CFDP
application communicates with the ION software which performs the CFDP work.

There are differences in capabilities and syntax between the CFDP Native mode and the
ION CFDP mode. These differences are summarized below.

Native CFDP Configuration
The syntax of a primitive is as follows:

[CFDP Directive] [Transmission] [source-path] [remote-EID] [destination-path]
Native CFDP Example: put class2 “D:\filel.txt” 2 “/home/kirk/filel.txt”

The TReK CFDP application currently supports multiple CFDP Directives for both
Native and ION CFDP modes. These are defined in the CFDP Directives section below.

Valid Transmission values are classl or class2. Class1 does not guarantee reliable
delivery of the file to the destination. Class2 does ensure reliable delivery.

The file you want to transfer is considered the “Source” and the location it should be
transferred to is considered the “Destination”.
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When entering a Source or Destination in a CFDP command line, it must be encapsulated
in double quotes.

ION CFDP Configuration
The syntax of a primitive is as follows:

[CFDP Directive] [Transmission] [source-path] [remote-EID] [destination-path]
ION CFDP Example: put //// “D:filel.txt” 2 “/home/kirk/filel.txt”

The TReK CFDP application currently supports multiple CFDP Directives for both
Native and ION CFDP modes. These are defined in the CFDP Directives section below.

The Transmission entry for ION CFDP is composed of five properties. Once these
properties are configured, a “////” string is used to indicate that the pre-configured values
should be used. The “////” nomenclature is shorthand notation for the following
combination of values:

Lifespan/Bundle Protocol Class of Service/Expedited Priority Ordinal/Transmission Mode/Criticality

When the values are empty it indicates that pre-configured values should be used for
these properties.

The Transmission properties are described below:

Property Description

Lifespan The lifespan is the bundle's "time to live" (TTL) in
seconds. The bundle is destroyed if its TTL has
expired and it has not reached its destination.

Bundle Protocol Class of Service | The Bundle Protocol Class of Service defines the
transmission priority of outbound bundles from three
ION priority queues corresponding to bulk, standard,
and expedited priorities. The expedited priority
queue must be empty before bundles in the standard
or bulk queues are serviced by ION. Therefore,
bundles with expedited priority should only be sent in
critical/lemergency situations.

Expedited Priority Ordinal The expedited priority ordinal is only associated with
the expedited priority class of service.
Transmission Mode The transmission mode defines the reliability of

bundle delivery to a destination. The three
transmission modes supported are best effort, assured,
and assured with custody transfer.

Criticality A critical bundle is one that has to reachits
destination as soon as is physically possible. For this
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reason, bundles flagged as critical may not include
custody transfer and require an ION configuration
with contact graph routing. In some cases, a critical
bundle may be sent over multiple routes to ensure
delivery to its final destination. Critical bundles are
placed in the expedited priority queue and should
only be used in emergency situations.

CEDP Directives

The TReK CFDP application currently supports multiple CFDP Directives for both
Native and ION CFDP modes. This includes get and put, multiple filestore directives,
and the message directive. These are defined as follows:

Directive Description

append_file append a file at the remote entity to another file at the remote
entity.

bit_rate changes the aggregate file transfer bit rate, in real time, for local or

remote entities hosting a TReK implementation of Native CFDP.
The “affected EID” may be the local entity ID or a remote entity
ID. The "bit_rate" primitive is delivered to a remote entity in the
form of a TReK CFDP message.

close_rec_file send a directive to a TReK Record library to close one or all open
record files. If the record file name is not included in the

primitive, all open record files associated with the TReK Record
library are closed. The TReK Record library automatically opens
a new record file after it closes a current record file. The “affected
EID” may be the local entity ID or a remote entity ID. The
"close_rec_file" directive is delivered to a remote entity in the
form of a TReK CFDP message.

create_dir create a directory at the remote entity.

create_file create anempty file at the remote entity.

delete_file delete afile atthe remote entity.

deny_dir delete a directory atthe remote entity. (like remove_dir, but does
not fail if the directory does not exist. Directory must be empty.)

deny_file delete a file atthe remote entity. (like delete_file, but does not fail
if the file does not exist)

get copy one file from the remote entity to the local entity. (File
cannot be empty.)

message send a text string to the remote entity.

put copy one file from the local entity to the remote entity. (File
cannot be empty.)

remove_dir delete a directory atthe remote entity (directory must be empty).

rename_file rename a file at the remote entity.

replace_file replace a file (contents) at the remote entity with another file

(contents) at the remote entity.
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Some directives only require a Source. The following table describes what is required for
Source and Destination for each directive. Name of file, filename, and name of directory

refer to an absolute path.

Directive Source (first file) Destination (second file)

append_file name of file whose contents name of file whose contents will form
form first part of new file and | second part of new file
name of the new file

bit_rate aggregate file transfer bit rate

close_rec_file | name of the TReK record name of the TReK record file to close
library device (if not included all record files

associated with the record device are
closed)

create_dir name of directory to be created

create_file filename to be created

delete_file filename to be deleted

deny_dir name of directory to be deleted

deny_file filename to be deleted

get file or directory name of file(s) | file or directory name for file(s)
to retrieve retrieved

message message

put file or directory name of file(s) | file or directory name for file(s) sent
to send

remove_dir Name of directory to be
deleted

rename_ file old filename new filename

replace_file filkname whose contents are to | filename whose contents will replace
be replaced the contents of the first filename

When entering a Source or Destination in a CFDP command line, it must be encapsulated
in double quotes.

Note: The Get directive is not supported in all ISS CFDP Native and ION

implementations.

Filestore and message directives are not supported in all ISS CFDP

Native implementations. They are supported by TReK when both the sender and receiver
are TReK CFDP implementations (TReK CFDP application, TReK CFDP console

application, or TReK CFDP Library).

In addition, the bit rate directive is not part of the

CFDP Blue Book and is only supported by the TReK CFDP implementation of Native

CFDP.

TReK also provides the capability to create CFDP dropboxes to push files to a remote
destination. The dropboxes are available in both Native and ION CFDP modes.
Dropbox configuration parameters include where the dropbox is located and the
destination of eachfile placed in the dropbox.
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In addition to this application, TReK also includes a CFDP console application and a
CFDP library. 1f you need CFDP functionality onboard a spacecraft consider the TReK
CFDP console application. 1f you need to include CFDP functionality in your own
application, consider the TReK CFDP library. The TReK CFDP library can be used to
include CFDP functionality in a ground or flight application.

4 Overview of the User Interface

4.1 Main Window

The main window contains several areas as shown in Figure 2. Eachareais a dock
window that you can float or dock. To float a dock window, use your left mouse button
to click and hold the title area while dragging the window to another area of the screen.
To dock, use the title bar to drag the dock window over the main window and drop.

r ~
[ TReK CFDP -- Untitled = | B S
File View CFDP Options Help
Configuration: . Configure | Operational: . Activate
CFDP Commands 8 x
Action Transmission Source Remote EID  Destination Add Row
Remawve Row
Export List
Import List
<< Show Directory Default Destination: | None A Clear Al Restore Al

Transactions g X

Transac tionID Action Remote EID  Status % Complete Bytes Transferred  Source Destination  Configuration  File Size

Figure 2 Main Window

Toolbar
The toolbar at the top of the window provides quick access to configure the application
and start and stop the CFDP service.

CFDP Commands

The CFDP Commands area provides a way to add and execute one or more CFDP
commands (primitives). For example, you can add a “put” command to send a file to a
remote entity. The “Show Directory” button provides access to the local file system.
Files canbe dragged from this view of the local file system or from a file explorer
window. Files can also be added by pushing the Add Row button and typing in the file
transfer information. To delete a file from the list put your cursor in the row you would
like to delete and push the Remove Row button. To delete all files in the list push the
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Clear All button. The Export List button provides a way to save the list of CFDP
Commands in afile. The Import List button provides a way to load a list of CFDP
Commands from a file. Each CFDP command entered into the list must include a
directive, transmission information, the absolute path of the source file, the Remote
Entity ID (Remote EID), and the absolute path of the destination file. To execute all the
CFDP commands in the list, push the Execute All button. After you push the Execute All
button, the Restore All button can be used to restore the list of commands. The Restore
All button will only restore the list of CFDP commands previously sent by pushing the
Execute All button. The Default Destination menu can be used to identify a default
destination. This can save typing when dragging and dropping files into the list. If the
Default Destination is set, the destination selected will automatically be copied into the
Destination field when a file is dropped into the list. The Default Destination menu can
be populated using the Configure dialog.

Note: You can enter the absolute path for a directory in the Source and Destination
fields. All the files in the first level of the directory will be transferred. Subdirectories
will not be transferred. Each file in the directory will result in the execution of an
individual CFDP Command (primitive). Therefore, the transactions area will contain
transaction information for each file transferred.

Note 2: There are two types of configuration files for the CFDP application: the CFDP
Application Configuration File and the CFDP Commands List file. File/Save/Save As
can be used to save an Application Configuration File. The File/Open command provides
away to open an Application Configuration File. The Export List button provides a way
to save a CFDP Commands List file. The Import List button provides a way to load a
CFDP Commands List file.

Transactions

The Transactions area displays file transfer activity. The Configure button displays the
Configure dialog which provides a way to show and hide columns and rearrange the
order of the columns. To Clear, Pause, Resume, or Cancel one or more transactions,
select the transactions in the list and push the desired button.

Message Area
The Message Area displays important status and error messages. The message area can

be cleared using the View menu.

4.2 Toolbar
The toolbar provides visual information about the state of the application and provides
access tocommon application functions.

Configuration Status
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When the Configuration statusis black, this indicates the application has not been
configured. When the Configuration status is green, this indicates the application has
been configured and the CFDP service can be activated.

Use the Configure button to access the Configure dialog to configure the application.

Operational Status

When the Operational status is black, this indicates the CFDP service is inactive. When
the Operational status is green, this indicates the CFDP service is active and file transfer
is supported. The application must be properly configured before the Activate button will
be available. The CFDP service must be active before the Deactivate button will be
available.

Use the Activate button to activate the CFDP service. This will initiate all internal
activities needed to prepare the application to send and receive files. When you activate
the CFDP service, you will see activation status messages in the main window message
area. If you need to reconfigure the CFDP application, deactivate the CFDP service, and
then push the Configure button to reconfigure.

5 TReK CFDP Tour

Sometimes it’s easier to learn how to use an application by example. This section
describes how to use the CFDP application to transfer a file using Native CFDP. To
learn about transferring a file using ION CFDP, please reference the TReK DTN
Tutorial.

This section was written assuming that you have read the Introduction section and the
Main Window section. Ifyou have not read these sections, please go back and read
them. They contain important information that is not repeated in this section.

If you have a firewall enabled on your computer, you may need to turn it off or allow
traffic through for the ports and protocols used in this example.

Please go through the tourin order. Some sections depend on data from previous
sections.
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How to Transfer a File
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5.1 Howto Transfer a File

The following steps describe the minimum necessary to transfer a file using Native
CFDP. Typically CFDP involves transferring files from one computer to another
computer. An instance of the CFDP application is run on each computer. The two CFDP
applications communicate with each other using the CCSDS File Delivery Protocol
(CFDP). While normally you run an instance of the CFDP application on each computer,
it is possible to run two instances on the same computer (doesn’t make a lot of sense but
is possible). In this configuration, you can transfer a file from one directory to another
directory on the same computer. To avoid the need for two computers, this is the
approach taken in this tutorial. The steps below describe how to use two instances of the
CFDP application running on the same computer to transfer a file from one directory to
another directory on the same computer using Native CFDP. The configuration that will
be used is shown in Figure 3.

CFDP Instance 1 CFDP Instance 2
Entity 1D (E1D] 1 CFDP Entity 1D (EID) 2
e o
<four Local IP Address> [~ “|<four Local IP Address=

Local Port 4560 Local Port 4545

Figure 3 Tutorial Configuration

While you will be doing this on asingle computer, the steps to configure and run will be
the same steps when you do this with two computers.

Step-By-Step
1. If you haven’t started the CFDP Application, use the operating system’s menu to start

the application. You should see the CFDP main window shown in Figure 4. We will
refer to this instance as CFDP Instance 1.

10
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TReK CFDP - Untitled

File View CFDP Options Help

Configuration: . Operational: . Activate Deactivate

CFDP Commands g X

Add Row

Remove Row

Action Transmission Source Remote EID  Destination

Export List

Import List

<< Show Directory

Transactions

Default Destination: Clear Al Restore All Execute All

TransactionID Action RemoteEID Status % Complete Bytes Transferred  Source Destination Configuration File Size

Pause Resume Cancel

g X

Figure 4 CFDP Main Window

11
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2. The Configuration Toolbar at the top of the main window contains a Configure
button. Push the Configure button to display the Configure dialog. You should see
the dialog shown in Figure 5.

7. Configure

Configuration: (®) Mative CFDP () IOMN CFDP

Mative CFDP Options Cryptography Summary
Local Entity ID: |1 |
Remote Entities

Remote EIl  Remote IP Address  Remote Port Add

Delete

CFDP Socket Local IP Address: 192, 168.1.51 || Browse...
CFDP Socket Lacal Port: |4560 |
CFDP Socket Queue Size: | 1000 |
Ack Timeout (seconds): | 15 |
Ack Limit: |25 |
Mak Timeout (seconds): | 15 |
Nak Limit: 100 |
Nak Maximum PDU Packet Size (bytes): | 15000 |
Inactivity Timeout (seconds): |300 |
Qutgoing File Chunk Size (bytes): |1300 |
Aggregate File Transfer Rate (bits/sec): |100EJUUUU |
Transaction Cyde Time Interval (milliseconds): | 1 |
Steps Per Transaction Cyde: |lD |

[] Auto Suspend and Resume

Maode: Peer to Peer Mode

Port: 43600

Connection Timeout {seconds): |3
Automatically Resize Mak Maximum PDU Packet Size if the Mak Packet Times Out

Ok Cancel

Figure 5 CFDP Configuration Dialog

12
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3. Ensure Native CFDP is selected. The Local Entity 1D is the Entity ID that will be
used by this CFDP application when it performs a file transfer. It defaults to 1.
This is the EID that should be used by CFDP Instance 1.

Note: If you have identified you will be using the CFDP capability in your
Payload Integration Agreement, you will be assigned a “Ground Node ID”. The
Ground Node ID is an Entity 1D and should be entered into the Local Entity 1D
field. 1f there are multiple people on your team, your team may have more than
one Ground Node ID. Each team member who needs to run the CFDP application
will need a unique Entity ID.

4. The next step is to identify the remote entity that this CFDP application will
communicate with. This will be CFDP Instance 2 (which we have not started
yet). Push the + button to create a row to enter the Remote Entity information.
Type in the following information:

Remote Entity ID: 2

Remote IP Address: <Your Local IP Address>

Remote Port: 4545

Note: The CFDP application cancommunicate with one or more remote entities.

Your dialog should now look similar to the dialog shown in Figure 6.

13
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7. Configure

Mative CFDP Options

Configuration: (®) Native CFDP  (O) ION CFDP

Cryptography Summary

Local Entity ID: |1

Remote Entities

Femote EID  Remote IP Address  Remote Port Add
2 192.168.1.51 4345 Delets

CFDP Socket Local IP Address: 192,168.1.51 | | Browse
CFDP Socket Local Port: |4560 |
CFDP Socket Queue Size: | 1000 |
Ack Timeout (seconds): |15 |
Ack Limit: |25 |
Mak Timeout {seconds): |15 |
Nak Limit: 100 |
Nak Maximum PDU Packet Size (bytes): 16000 |
Inactivity Timeout (seconds): |30U |
Outgeing File Chunk Size (bytes): |1300 |
Aggregate File Transfer Rate (bits/sec): |1UUUUUUU |
Transaction Cyde Time Interval (miliseconds): |1 |
Steps Per Transaction Cycle: |1[J |

(] auto Suspend and Resume

Mode: Peer to Peer Mode

Fart: 45600

Connection Timeout {(seconds): |3
Automatically Resize Mak Maximum PDU Packet Size if the Mak Packet Times Cut

OK Cancel

Figure 6 Configuration with Remote Entity

5. Ensure the CFDP Socket Local IP Address and the Remote IP Address contains your

local IP address.

6. All the other defaults in the dialog are acceptable.

14
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7. Push the OK button to save the configuration information and exit the dialog.

8. If the application is configured correctly, the Configuration status in the main window
will be green as shown in Figure 7. If you do not see green, the most likely problem
is the local IP address. Verify that you have entered a valid local IP address for your
computer.

File View CFDP Options Help

Configuration: . Operational: . Deactivate

CFDP Commands

Action Transmission Source Remote EID  Destination Add Row
Remove Row

& X

Export List

Import List

<< Show Directory Default Destination: Clear Al Restore All Execute All

Transactions

Transaction ID Action Remote EID  Status % Complete Bytes Transferred  Source Destination Configuration File Size

Clear Pause Resume Cancel

[

Message Area

Figure 7 Configuration Status

9. Go to the File menu and save the configuration naming it CFDP_Instance_1. This
will update the application title bar and make it easier to distinguish between the two
instances once we have both instances running. This is shown in Figure 8.

15
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T8 TReK CFDP - CFDP. —Talex

File  View CFDP Options Help
Configuration: [ operational: [l Deactivate

CFDP Commands

Action Transmission Source RemoteEID Destination Add Row

Remove Row

Export List

<< Show Directory Default Destination: Clear Al Restore Al || Execute al | [ Imeortlist

g X

Transactions

TransactionID Action Remote EID Status % Complete Bytes Transferred  Source Destination Configuration File Size

Configure... Clear Pause Resume Cancel

Message Area g X

GMT 2016-02-16 17:42:46:933 Info: Configuration C:/Users/kirk/CFDP_Instance_1 has been saved.

Figure 8 CFDP_Instance_1

10. Push the Activate button located in the Configuration Toolbar in the main window.
This will activate all the underlying services needed to perform CFDP functions. If
activation is successful, your main window should look like the one shown in Figure
9. The Operational Status will be green.

E — e,

File View CFDP Options Help

Configuration: . Operational: . Activate

CFDP Commands g X
Action Transmission Source Remote EID  Destination Add Row
Remove Row
Export List
Default Destination: Clear Al Restore Al Execute All
Transactions g X

TransactionID Action Remote EID  Status % Complete Bytes Transferred  Source Destination Configuration File Size

Configure. .. Clear Pause Resume Cancel

Message Area g X

GMT 2016-02-16 17:42:46:933 Info: Configuration C:/Users kirk/CFDP_Instance_1 has been saved.
GMT 2016-02-16 17:44:27:204 Info: Successfully activated CFDP service,

Figure 9 CFDP_Instance_1 Activated

16
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11. Now that one instance is configured and running, launch a second instance of the
CFDP application.

12. In the second instance of the CFDP application, push the Configure button and update
the following:

Local Entity ID: 2

Remote Entity ID: 1

Remote IP Address: <Your Local IP Address>
Remote Port: 4560

CFDP Socket Local Port: 4545

17
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Configure
Configuration: (® MNative CFOP () ION CFDP
Mative CFDP Options Cryptography Summary
Local Entity ID: |2 |
Remote Entities
Remote EID  Remote IP Address  Remote Port Add
1 192.168.1.51 4560 Delets
CFDP Socket Local IP Address: 182, 168.1.51 | | Browse...
CFDP Socket Lacal Port: |4545 |
CFDP Socket Queue Size: | 1000 |
Ack Timeout (seconds): | 15 |
Ack Limit; |25 |
Mak Timeout (seconds): | 15 |
Nak Limit: 100 |
Nak Maximum PDU Packet Size (bytes): | 16000 |
Inactivity Timeout (seconds): |30I] |
Outgoing File Chunk Size (bytes): |130EI |
Aggreqgate File Transfer Rate (bits/sec): |IDDDDDDD |
Transaction Cyde Time Interval (milliseconds): | 1 |
Steps Per Transaction Cyde: |1IJ |
[] auto Suspend and Resume
Mode: Peer to Peer Mode
Port: #5500
Connection Timeout (seconds): |2
Automatically Resize Mak Maximum POU Packet Size if the Mak Packet Times Out
Ok Cancel

Figure 10 Configuration for CFDP_Instance_2

Note: Now that you have configured both instances you can compare the configuration
information. You configured each instance with local entity information and remote
entity information.  Both instances have information needed to communicate with the
other. Asa reminder, the tutorial configuration is shown in Figure 11.

18
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CFDP Instance 1 CFDP Instance 2
Entity ID (EID) 1 CFDP Entity 1D (EID) 2
| e
<Your Local IP Address= [~ “|<¥our Local IP Address=>
Local Port 4560 Local Port 4545

Figure 11 Tutorial Configuration Reminder

13. Push the OK button to save the configuration information and exit the dialog.
14. Verify the Configuration status is green.
15. Go to the File menu and save the configuration as CFDP_Instance_2.

16. Push the Activate button located in the Configuration Toolbar in the main window.
This will activate all the underlying services needed to perform CFDP functions. If
activation is successful, the main window for CFDP Instance 2 should look like the
one shown in Figure 12. The Operational Status will be green.

TReK CFDP -- CFDP_Instance_2 =k

File View CFDP Options Help

Configuration: [l Operational: [l | Activate

CFDP Commands g X
Action Transmission Source RemoteEID  Destination Add Row

Remove Row

Export List

<< Show Directory Default Destination: Clear Al Restore All || Execute i | [ ZmROrEList

Transactions g x|

TransactionID Action RemoteEID Status % Complete Bytes Transferred  Source Destination Cenfiguration File Size

Configure. .. Clear Pause Resume Cancel

Message Area g x

GMT 2016-02-16 17:49:36:793 Info: Configuration C:/Users kirk/CFDP_Instance_2 has been saved.
GMT 2016-02-16 17:50:03:615 Info: Successfully activated CFDP service,

Figure 12 CFDP_Instance_2

17. You are now ready to transfer a file. The easiest way to identify the file(s) you want
to transfer is to use drag and drop to drop the file(s) into the main window CFDP
Commands list. To get some extra help from the application, you can set some
application defaults that will fill in information in the CFDP Commands list when
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you drop files into the list. So before transferring a file, let’s set the defaults used by
drag and drop. Pushthe Configure button in the main window configuration toolbar.
Go to the Options tab. Set the Default Remote EID to 2 as shown in Figure 13.

Coenfigure

[

Configuration: (®) Mative CFDP () IOM CFDP

Mative CFDP Options Cryptography Summary

Default Remote EID: 2

Default Destination Paths

Destination Path Add
Delete
CFDF Dropbox List
Transmission Dropbox Path  Remote EID  Destination Path  Retry Limit  Successful Path Add
Delete

Set Dropbox Path...

Set Successful Path...

Fragmentation Dropbox List

Dropbox Type Dropbox Path  Destination Path  File Fragmentation Size  Successful Path Add

Delete
Set Dropbox Path...

Set Successful Path...

|:| Log Metrics
Log File Path:  |C:/Users/kirk

Log File Mame: |toolkit_cfdp_metrics

0K Cancel

Figure 13 CFDP Configuration Options Tab

18. Push the + button to add a row to the Default Destination Paths list. Enter the
absolute path for your home directory (<C:\Users\<your username> on Windows or
/home/<username> on Linux) on your computer. Your dialog should be similar to
the one shown in Figure 14.
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7. Configure

[

Configuration: (®) Mative CFDP () IOM CFDP

Mative CFDP Options Cryptography Summary

Default Remote EID: 2
Default Destination Paths

Destination Path Add

Ch\Usershkirk Delets

CFDF Dropbox List

Transmission Dropbox Path  Remote EID  Destination Path  Retry Limit  Successful Path Add
Delete
Set Dropbox Path...

Set Successful Path...

Fragmentation Dropbox List

Dropbox Type Dropbox Path  Destination Path  File Fragmentation Size  Successful Path Add

Delete
Set Dropbox Path...

Set Successful Path...

|:| Log Metrics
Log File Path:  |C:/Users/kirk

Log File Mame: |toolkit_cfdp_metrics

0K Cancel

Figure 14 Default Destination Path

When you drag and drop a file the Remote EID will automatically be populated for you
with the Default Remote EID. The Default Destination Paths will appear on the Default
Destinations menu in the application (more on this below).

19. Push the OK button to save the configuration information and exit the dialog.

20. In the main window under the CFDP Commands list, there is an option menu called
Default Destinations. Select the path you entered in the Default Destinations list in
the Configuration dialog (<C:\Users\<your username> on Windows or
/home/<username> on Linux). Your CFDP_Instance_1 main window should look
like the one shown in Figure 15.
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T8 TReK CFDP — CFDP_Instance

File View CFDP Options Help

Configuration: . Operational: . Activate

CFDP Commands & X
Action Transmission Source RemoteEID  Destination Add Row
l Remove Row
Export List
i Default Destination: Clear Al Restore All || Execute All
Transactions & X

Transaction D Action Remote EID  Status % Complete Bytes Transferred  Source Destination Configuration File Size

Configure... Clear Fause Resume Cancel

Message Area & x

GMT 2016-02-16 17:42:46:933 Info: Configuration C:/Users kirk/CFDP_Instance_1i has been saved.
GMT 2016-02-16 17:44:27:204 Info: Successfully activated CFDP service,

Figure 15 Main Window with Default Destination Selected

21. Let’s transfer a file. Open afile explorer window and select a file to transfer. Make
sure it is not a file in your home directory since that is the destination of the file.
Drag the file from the file explorer window and drop it into the CFDP_Instance 1
CFDP Commands List. If all the information about the file is valid, your main
window should look similar to the one shown in Figure 16.
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File View CFDP Options

Configuration:

Help

TREK-USER-0006

Operational: Activate

Message Area

GMT 2016-02-16 17:44:27:204 Info

1 Successfully activated CFDP service,

GMT 2016-02-16 17:42:46:933 Info: Configuration C:/Users/kirk/CFDP_Instance_1 has been saved,

CFDP Commands 5 X
Action  Transmission Source Remote EID Destination Add Row
1 put  class2 C/cfdptest/filel.bt 2 C:/fUsers/kirk/filel bt
Export List
<< Show Directory Default Destination: [C:V..lsers‘qkirk\ A H Clear all Restore All Execute Al imnnghlist
}
Transactions 5 X
Transaction D Action RemoteEID Status % Complete Bytes Transferred  Source Destination Configuration File Size
Clear Pause Resume Cancel
& X

Figure 16 CFDP Commands List

Let’s take a look at what we have in the list.

CFDP Command Syn

tax

[CFDP Directive] [Transmission] [source-path] [remote-EID] [destination-path]

CFDP Command

put class2 c:/ctdptest/filel.txt 2 C:/Users/kirk/filel.txt

Command Field

Value

Description

Put/Get put Indicates the file will be *put’ (copied) fromthe local entity
(CFDP_Instance 1)totheremote entity (CFDP_Instance 2)
Transmission class2 Class 2 ensuresreliable file delivery; any required

retransmissions are requested and performed by CFDP.

Source C:/cfdptest/filel.txt Identifies the ‘source’ file you wish to transferto the
destination (CFDP_Instance_2). (Note: Double quotesare
not required when entering data in the CFDP Commands
List.)

Remote EID 2 Identifies the remote entity ID is 2.

Destination C:/Users/kirk/filel.txt | Identifies the *destination’ file by providing the absolute

path and filename that should be used whenthe file is placed
at the destination. (Note: Double quotes are notrequired
when entering datain the CFDP Commands List.)

22. Everything is ready to go. Push the Execute All button in the CFDP_Instance 1 main

window.

23. You should see the Transactions area populated with transaction information in both
the CFDP_Instance_1 main window and the CFDP_Instance_2 main window as
shown below in Figure 17 and Figure 18. Use the file explorer window to look at
your home directory and you should see the file you transferred.
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File View CFDP Options Help

Configuration: . Operational: . Activate

CFDP Commands 8 x
Action Transmission Source Remote EID Destination Add Row
l Remove Row
Export List
I Default Destination: | C: Wsers\kirky  — Clear all Execute All Import List
Transactions g x
Transaction ID  Action Remote EID  Status % Complete Bytes Transferred  Source Destination Configuration File Size
11 put 2 Success 100 2 Ci/cfdptest/filel.bt Co/Users/kirk/filel.bd Sender 2

Clear Pause Resume Cancel

Message Area = ¢

GMT 2016-02-16 17:
GMT 2015-02-16 17:

: Configuration C: /Users kirk/CFDP_Instance_1 has been saved.
: Successfully activated CFDP service. |

GMT 20156-02-16 17: 3:337 Infor Transaction started: 1_1 (cfdp_transceiver.cpp:632)
GMT 2016-02-16 17: 3:338 Infor Transaction: 1_1 (C:jcfdptest/file1.tut -= C:/Usersjkirk{file 1. tet) (cfdp_transceiver.cpp:836)
GMT 2016-02-16 17:58:53:411 Info: Transaction 1_1 {C:/cfdptest/filel.tet -» C: Users kirk ffile 1. txt): successful (cfdp_transceiver. cpp: 2064)

Figure 17 CFDP_Instance_1 Transaction Information
rﬂ TReK CFDP — CFDP Instance 2 . .. Y - E=nrE! g

File View CFDP Options Help

Configuration: . Operational: . Activate

CFDP Commands g X

Action Transmission Source RemoteEID  Destination Add Row
Remaove Row
Export List

<< Show Directory Default Destination: Clear All Restore Al Execute Al

Transactions & X
TransactionID Action Remote EID  Status % Complete Bytes Transferred  Source Destination Configuration File Size
11 put 1 Success 100 2 Ci/cfdptest/filel bt C:/Users/kirk/filel bt Receiver 2

Clear Pause Resume Cancel

Message Area g X

GMT 2016-02-16 17:49:36:793 Info: Configuration C: /Users/kirk/CFDP_Instance_2 has been saved.

GMT 2016-02-16 17:50:03:615 Info: Successfully activated CFDP service.

GMT 2016-02-16 17:58:53:354 Info: Transaction started: 1_1 (cfdp_transceiver.cpp:632)

GMT 2016-02-16 17:58:53:355 Info: Transaction metadata: 1_1 (C:/cfdptest/file 1 tut - C: fUsers kirk/file1. tet) (cfdp_transceiver. cpp: 1680)
GMT 2016-02-16 17:58:53:394 Info: Transaction 1_1 (C:/cfdptest/file 1.tut -= C: /Users kirk /file 1. tet): successful (cfdp_transceiver.cpp: 2064)

m._| »

1

Figure 18 CFDP_Instance_2 Transaction Information

That’s it! You have successfully transferred a file using CFDP. For more information
please see the TReK CFDP User Guide.

Happy Transferring!!!
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